TRAINING MANUAL

EE-310

DIGITAL SYSTEM ENGINEERING






TRAINING MANUAL
Unit 9 - Getting Started With RTOS

Getting Started With RTOS

Time allocation: 3 Hours

Objectives

The aim of this module is to get immersed into embedded programming on a real hardware.
To complete the basic workflow, simple applications are developed, implemented, and
demonstrated in an Embedded System work environment. Experiment(s) in this module are
conducted using Real-Time OS (RTOS) to demonstrate some of the most common practical
applications.

Resources

%  Desktop PC / Laptop

Software development Tools

Embedded Kit (ARM Cortex Series)

Jumper Wires / Breadboard / LEDs, Switches

- = +

Topics to be covered:
1.  Getting Started a Tutorial Project
2. ARM Cortex M4 1/0 Programming
3. GPIO (General Purpose 1/0) Programming and Interfacing
4.  Reading Switches and Displaying the same on LEDs
5. Standard Application(s) Interfacing and Programming
6. Realization of FreeRTOS (Real-Time Operating System)

7. Internet-of-Things (I0T) Application(s) Interfacing and Programming
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STM32 (ARM Cortex M4)
Starter Kit - Development
and Education Board

(STM32 pController)

Document: Datasheet (stm3214s5) and Reference manual (stm3214s5)
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Expansion Connector
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Getting Started With Embedded RTOS (freeRTOS)

What is an RTOS and Multitasking?

A RTOS is a real-time operating system which manages software and hardware resources on a
computing system and provides services to application software which are not possible with bare

metal.

User RTOS
A v Architecture
Application

Examples:

Operating System
o freetRTOS

A V . Kell RTX

e UC/OS

Hardware

A RTOS is basically a software component that rapidly switches between tasks, giving the impression

that multiple programs are being executed at the same time on a single processing core.

In actual fact the processing core can only execute one program at any one time, and what the RTOS
is actually doing is rapidly switching between individual programming threads (or Tasks) to give the

impression that multiple programs are executing simultaneously.

When switching between Tasks the RTOS has to choose the most appropriate task to load next. There
are several scheduling algorithms available. However, to provide a responsive system most RTOS use

a pre-emptive scheduling algorithm.

In a pre-emptive system each Task is given an individual priority value. The faster the required
response, the higher the priority level assigned. When working in pre-emptive mode, the task chosen
to execute is the highest priority task that is able to execute. This results in a highly responsive
system.
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While selecting a RTOS, one of the most important considerations is what type of response is desired
— Is a hard real time response required? This means that there are precisely defined deadlines that, if
not met, will cause the system to fail. Alternatively, would a non-deterministic, soft real time response

be appropriate? In which case there are no guarantees as to when each task will complete.
The choice of RTOS can greatly affect the development of the design.
By selecting an appropriate RTOS the developer gains:

e A Task based design that enhances modularity, simplifies testing and encourages code reuse;
e Anenvironment that makes it easier for engineering teams to develop together;

e Abstraction of timing behaviour from functional behaviour, which should result in smaller

code size and more efficient use of available resources.

Peripheral support, memory usage and real-time capability are key features that govern the suitability
of the RTOS. Using the wrong RTOS, particularly one that does not provide sufficient real time
capability, will severely compromise the design and viability of the final product.

The RTOS needs to be of high quality and easy to use. Developing embedded projects is difficult and
time consuming — the developer does not want to be struggling with RTOS related problems as well.
The RTOS must be a trusted component that the developer can rely on, supported by in-depth training

and good, responsive support. FreeRTOS could be one of best choices amongst so many in the field.

What is FreeRTOS?

FreeRTOS is a class of RTOS that is designed to be small enough to run on a microcontroller (UC). A
microcontroller is a small and resource constrained processor that incorporates, on a single chip, the
processor itself, read only memory (ROM / Flash) to hold the program to be executed, and the random
access memory (RAM) needed by the programs it executes. Typically the program is executed from

the read only memory. One of the main attractions in freeRTOS is its free of cost licensing model.

Microcontrollers are a central piece of the embedded systems that normally have a very specific job to
do. The size constraints, and dedicated end application nature, rarely warrant the use of a full package

implementation.

Applications - few to mention:

Command and control systems, heart pacemaker, industrial automation, and modern robotics systems
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Key Features - Tasks Synchronization through Semaphores / Queues

Producer Threads

I
e

Receiver

Message Queues

Consumer Threads

e, | am task #1
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FreeRTOS architecture

)
Jake) uopeNEg Y
AEMUEH
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https://www.st.com/resource/en/user_manual/dm00105262-developing-applications-on-stm32cube-with-rtos-stmicroelectronics.pdf
https://www.st.com/resource/en/user_manual/dm00105262-developing-applications-on-stm32cube-with-rtos-stmicroelectronics.pdf
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FreeRTOS APIs

APls Categories API

— xTaskCreate @
vTaskDelete

Task Creation

vTaskDelay
vTaskDelaylntil .
uxTaskPriorityGet
vTaskPrioritySet
vTaskSuspend

vTaskResume
xTaskResumeFromISR
vTaskSetApplicationTag
xTaskCallApplicationTaskHook

Task Control

¥TaskGetCurrentTaskHandle
xTaskGetSchedulerState
uxTaskGetNumberOfTasks
vTaskList

vTaskStarnTrace
ulTaskEndTrace
vTaskGetRunTimeStats

vTaskStartScheduler @
vTaskEndScheduler
vTaskSuspendAll
xTaskResumeAll

Task Utilities

Kernel Control

xQueueCreate

xQueueSend

— xQueueReceive

— xQueuePeek

— xQueueSendFromISR

— xQueueSendToBackFromISR
— xQueueSendToFrontFromISR
— xQueueReceiveFromISR

— vQueueAddToReqistry

— vQueueUnregisterQueue

Queue Management

— vSemaphoreCreateBinary @
— vSemaphoreCreateCounting
— xSemaphoreCreateMutex

— xSemaphoreTake

- xSemaphoreGive.

— xSemaphoreGiveFromISR

Semaphores
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This task demonstrates:

o Simple working of a freeRTOS on STM32L4S5 device

Objective

e Learn how to set-up Real-Time OS

o Create applications to start the freeRTOS

e Generate code in STM32Cube Tools using CMSIS functions

On the target board,

You will use GP10s (LEDs) and/or USART (Tera-Term) to demonstrate the working of RTOS.
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Procedure

Launch “STM32CubeIDE” Development Tool

Double Click the Icon

Open a
new
project

File > New Project
= STM32 Project

cc - 5TM32CubelDE
File /Edit Source Refactor Mavigate Search Project Run Window Help

MNew Alt+5Shift+N » Makefile Project with Existing Code
Open File... C/C++ Project
(", Open Projects from File System... E 5TM32 Project <:

Select “Hardware Platform”

m Mew Project

Selector

MCLMPL Selectar

-Board Filters

Example

Commercial
Part Mumber o N LR Y P

B-L475E-OTO1A2

Q B-L4S5HOTO1A <=

B-U585HOTOZA
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Select the specific “h/w board”, (if there are multiple options)

Boards List: 1 item

__* | Overview X

Commercial Part No

<Next>

SEsEEEEEEEEEEEEEY

*

Docs & Resource [j Datasheet [ Buy

Features Large Picture

CLETT TN
anadnn

AR RRRRRRRRRRN RN R

STM32L4+ Series

B-L4S51-I0T01A STM32L4+ Discovery kit loT node, low-power wireless, BLE, NFC, WiFi

[AcTivE] Part Number : B-L4SSHOTO1A bt o e

Product is in mass production Commercial Part Number : B-L4S5I-I0T01A Mounted Device - STM32L 4S5VIT6

With the B-L4S5I-/OT01A Discovery kit for loT
node, users develop applications with direct
connection to cloud servers. The Discovery kit
enables a wide diversity of applications by
exploiting low-power communication, multiway
sensing and Arm® Cortex®-M4 core-based
STM32L4+ Series features. The support for

ARDUINO® Uno V3 and Pmod™ connectivity

enum,
. .

*

STM32Cube_FW_L4 V1.17.2: > Drivers
MName s o e,
““‘ .‘ o ‘-....0
BSP - g
Drivers » STM32L4xx_HAL Driver » Inc
CMSIS % y
STM32Ldxx_HAL_Driver Name a

Legacy
E strm32_assert_termnplate
| stm32M0c_hal
| stm32Mxx_hal_adc
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Type in “Project name”

[ 5TM32 Project O

Setup 5TM32 project

Project u

Project Name: | [TIPEE,
[+] Use default location

Location: Cifabxabec Browse...

Opticns

/Targeted Language \

@C l:::IC++

Targeted Binary Type
(®) Executable () Static Libran

Targeted Project Type
\@ STM32Cube O Empty/

[ Board Project Options: x

@ Initialize all peripherals with their default Mode ?
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Reset “default Pinout”

e Select “Pinout & Configuration”,
e Click “Pinout”

¢ Right Click, “Clear Pinouts”

STM32 ﬁ File Window Help

CubeMX
itled - Pinout & Configuration

Clock Configuration Project Manager
v Software Packs

[0 Keep Current Signals Placement  Ctri<

System Core > ‘ Show User Label

Disable All Modeg Ctri-D
Analog ’ Clear Pinouts \—l CtriP
Timers N C.\ear Single Map.ped Signals T

Pins/Signals Options... a=
Connectivity > . List Pinout Compatible MCUs Alt-L

- Export pinout with Alt. Functions

Multimedia ’ Export pinout without Alt. Functions CirkU
Security >

Set unused GPIOs CirlG
Computing > F ik ELE LS Pinout View Colors

LQFP100
Layout reset
Middleware and Software Pac... »

STM32 ﬁ File Window Help

CubeMX
ntitled - Pinout & Configuration

Pinout & Configuration Clock Configuration
v Software Packs v Pinout

{5 Pinout view

Categories

System Core A

DMA

GPIO

Analog ke

N STM32L4S5VITx
LQFP100

Timers
Caonnectivity >

Multimedia »

Security
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H/W Configuration

To demonstrate working of the given exercise,

Configure GPIO ports

B.'=|5"3":'°‘"l
Right Click on PA0O-PA7, PB14 nd LEDS -
. s d
Select, GPIO_Output switche m boar
Try, C&C custo
7

Right Click on PCO- PC3, PC13
Select, GPIO_Input // With Pull-Up

,- ——————
GPIO_Input _
GRIO_nput |28 ]
GPIO_Input  [ge

foee: 2 STM32L4S5VITx
4 LQFP100

o —

on T = ——

,’ GPID_Output

: CPIO._Output

1

| |GRIO_Output ;

1

I w [ = L I

1 e R = R 2
I EEE EE 2 EHEE
1 ]

! H R AL

1 5 5 5 5 51

1 =} S 9 9 9l

1 o o o o ol

1 T g o & ol

(Y L] I L |

\ 7

\ U4

\N- ————————————————————— —',

=>» This enables:
o Clock for port(s), and
o Sets the direction of the port as an input or output
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Click “Pinout & Configuration”

Configure GPIO (mode)
Categories | A-=7 Configuration
System Core v |Grnup By Peripherals
:
DMA
GPIO Search Signals
WDG -
NVIC
gﬁg GPIG outp. . GPIO made GPIO Pull-up/Pull-down
15 Output Push Pull Mo pull-up and no pull-down
WWDG F'A‘I m'a an Output Push Pull Mo pull-up and no pull-down
PAZ nfa Low Output Push Pull Mo pull-up and no pull-down
PA3 nia Low Qutput Push Pull Mo pull-up and no pull-down
Analog 5 PCO nfa nfa Input mode Pull-up
PC1 nfa nfa Input mode Pull-up
Timers > onﬁguraa'tiun : : - : ( -
Connectivity 5 GPIO output level Low
Multimedia > GPIO mode Output Push Pull
Security b GPIO Pull-up/Pull-down ‘Nn pull-up and no pull-down
F
PCO nia nfa Input mode Pull-up
PCH nia n'a Input mode FPull-up
PCZ nia nfa Input mode Pull-up
PC3 n/a n'a Input mode Pull-up
Cnnﬁguratiun :
GFIO mode |Input mode

GPIO Pull-up/Pull-down

ull-up

User Label |
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Configure FreeRTOS
oftware Pa Pino
& FREERTOS Made and Configuration
Nultimedia s
: Interfacff|CMISIS_v2 v]
. Security >

Computing T
: >Midd|eware and Software Packs Reset Configuration

-

FATFS imats an
B e msnT0s Tas lame 1. SiacSizJEny Fun o Gen. | Paramete | Alscaton e NanelCoiol 5.
£} -CUBE-emb0S defayltTask 128 StartDefa... Default NULL Dynamic  MWULL MULL

£} 1-CUBE-wolfSSL
£} 1-Cube-Sol-uGOAL

Add Delete

rQueues

Configure / Edit default Tasks

| ————————

Edit Task
Task Mame Taskl
Priority DSPrinri@Nurmal )
Stack Size (Words) (128 ~—"
Entry Function StartTask
Code Generation Option|Default

Parameter MULL Mew Task E |

Allocation Dynamic Task Name Task?2 7

Buffer Name Priority DSF'riurit(E}eIannrmaD v

Control Block Name Stack Size (Words) 128 = ~——"

oK Entry Function StartTask2
Code Generation Option|Default ~
Parameter MULL
Allocation Oynamic ~
Add a 2nd Task Buffer Name
o Click “Add” Contral Block Name
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Optional — Enable library (new version)

Lontguration

Reset Configuration

Configure the below parameters :

J
Q | ® © (i ]
~ Mewlib settings (see parameter des..
USE_MNEWLIB_REENTRANT
~ Project settings (see parameter des..
Use FW pack heap file Enabled
Choose Timer as the HAL Timebase Source (Instead of Systick)
Q| V| L2 " S¥S Mode and Configuration
Categories | A-: Mode
System Core — Debug |Disable
N [0 System Wake-Up 1
DIMA, O System Wake-Up 2
E“EE':;% O System Wake-Up 3
NWIC [J System Wake-Up 4
E’F;gg“ O System Wake-Up &
TSC Power Voltage Detector In |Disable
VDG VREFBUF Mode |Dis
Timebase Sourcf | TIM2 ‘\
Analog 2
NOTE:

The SysTick is a special timer in most ARM processors that’s generally reserved for operating system purposes. By
default, SysTick will be used for things like HAL_Delay() and HAL_GetTick(). As a result, the STM32 HAL framework
gives SysTick a very high priority. However, FreeRTOS needs SysTick for its scheduler, and it requires SysTick to be a

much lower priority. Therefore, a quick work around is to use a Timer as a Time-base source in the cases of freeRTOS.
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Generate Code

enum,y
o %o,
.
-

File Edit Mavigate Search: F'rujec.i Fun  Window Help

.
s
.

'---"u—. 1 B
M - - - Open Project

35 Project Explorer % Sondlel

hell224 oy Build All Ctrl+B
hellod22 Build Configurations H
hello223 Build Project
Build Working Set ¥
Clean...

Build Automatically

C/C++ Index ¥

(Generate Report

Generate Code <:

Properties

Dpen Associated Perspective? >

This action can be associated with C/C++ perspective. Do you want to open this
perspective now?

[ ] Remember my decision

.
ot N,

Yes » Mo

.

R 3

.

Apapt®
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Task-1

This task demonstrates how to:

e Configure GPIO ports
o Create multiple Tasks in RTOS (FreeRTOS)

e Toggles a set of LEDs (PA5 & PB14) of PORTA & PORTB through Tasks- 1 & 2

e —

TASKSTART()

LED(s)

e Sample Code for this task is given next
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Sample Code to update “main.c”

void StartTask1(void *argument)
{
/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{
GPIOB->0DR "= (0x1 << 14); //PB14 ON
osDelay(100); // vTaskDelay(100);
}
/* USER CODE END 5 */

}

void StartTask2(void *argument)

{
/* USER CODE BEGIN StartTask2 */

/* Infinite loop */

for(;;)
{
GPIOA->0DR ”= (0x1 << 5); //PA5 ON
osDelay(50);
}
/* USER CODE END StartTask2 */
}

» Build “Project”
» Flash “binary code” on the h/w
» Reset h/w board (By pressing switch/button on the board)

» Monitor “LEDS” toggling on the h/w board

22| Page
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Add “Semaphore” feature (Continuation to previous task)

Pinout & Configuration Clock Configuration Project Manager

v Software Packs v Pinout

FREERTOS Mode and Configuration

USAHITZ
USART3
USB_OTG FS

Interigce (CMSIS_V2 V]

Configuration
Multimedia M :
| Reset Configuration

| Security ? @ FreeRTOS Heap Usage
& Timers and Semaphores
~ Computing ? @ Advanced settings

r Timers

. Middleware and Software Packs Callback | __Type __[Code Generat._|_Parameter | _Allocation _[Control Block._

&

FATFS Add Delete
U
o FREERTOS -Binary Semaphores
¥ Semaphore Name Control Block Name
£} -CUBE-UNISONRTOS N
£} -CUBE-emb0S ——
£} |-CUBE-wolfSSL o

Edit Binary Sermaphore >

Semaphore Mame |imyBinarySema

Allocation Dynamic ~

Control Block Mame

Cancel

Click “Generate Code”
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Sample Code to update “main.c”

void StartTask1(void *argument)

{
/* USER CODE BEGIN 5 */

/* Infinite loop */
for(;;)
{

osSemaphoreRelease(myBinarySemaHandle);

GPIOB->0DR "= (0x1 << 14); //PB14 ON
osDelay(100);

}
/* USER CODE END 5 */

}

void StartTask2(void *argument)
{
/* USER CODE BEGIN StartTask2 */
/* Infinite loop */
for(;;)
{

osSemaphoreAcquire(myBinarySemaHandle, osWaitForever);

GPIOA->ODR "= (0x1 << 5); //PA5 ON

}
/* USER CODE END StartTask2 */

» Build “Project”
» Flash “binary code” on the h/w
» Reset h/w board (By pressing switch/button on the board)

» Monitor “LEDS” toggling on the h/w board

24| Page
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Add “Queue” feature (Continuation to previous task)

Project Manager

Clock Configuration
v Software Packs
FREERTOS Mode and Configuration

Pinout & Configuration

v Pinout

USARI 2
USART3
USB_OTG FS

Configuration
Multimedia > :
i Reset Configuration

Security ’ @ Events
stants © Tasks and Queues
. Computing b ENEICTH @ Include parameters
rTasks
 Middleware and Software Packs Task Name !
N Task1 StartTask1 Default NULL Dynamic NULL MNULL
FATFS Task2 128 StartTask?2 Default NULL Dynamic  NULL MNULL
4
& FREERTOS
) Add Delete
gromusamos |l o
B | Queue Name | _Queue Size [ _Item Size | Alocation | _Buffer Name _[Control Block N._|
a . CUBE-wolfSSL Queue Name Queue Size Item Size Allocation Buffer Mame  |Control Block N...
£ 1-Cube-SoM-uGOAL
£} X-CUBE-Al Delete
ala
Edit Clueue >
Clueue Mame myQueue \
Queue Size 16
ltem Size uint16_t
Allocation Chynamic W
Buffer Name
Buffer size nfa
Control Block Narrk /
Cancel
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Pinout & Configuration

Configure USART Pins

Q| V| L6 USART1 Mode and Configuration

Categories | A->Z Mode

12C3 Mode|f‘-‘\synchrunuus ‘ V|
12C4
Hardware Flow Control (RS232) [Disable v |

LPUART1 [ Hardware Flow Control (RS485)
DOCTOSPNH

DCTOSPI2 Slave Select(NS5) Management
SDMMCA
SPH
SPI2

R
UART4 Reset Configuration

UARTS ings I tings 10 Settings

LUSARTZ l

USART3
USB_OTG_FS

Disable

Configuration

Voltimedia N PinNa__ |Signal on _|GPIO outp | GPIO mode [GPIO Pull- [Maximum | Fast Mods

PB& USART1_TX nia Alternate ... Mo pull-up ... Very High  Disable
Security 5 PB7 USART1_RX nfa Alternate ... No pull-up ... Very High  Disable

n LISARTT_RX
y LISARTT_TX

Click

“Generate Code”
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Sample Code to update “main.c”

/* USER CODE BEGIN 0 */

#include <stdio.h>

typedef struct{ // object data type
uint8_t Idx;
uint8_t Buf[5];

} MSGQUEUE_OBJ_t;

/* USER CODE END 0 */

// Update queue size in “main.c”

/* creation of myQueue */

myQueueHandle = osMessageQueueNe sizeof{ MSGQUEUE_OB]J_t )] &myQueue_attributes);

void StartTaskl(void *argument)

{
MSGQUEUE_OBJ_t msg [16] = {
{'A*, {1,2,3,4,5} },
{'8", {6,7,8,9,10} },
{'c', {11,12,13,14,15} }
}s /1 = {e};
uint8_t i=0;
osStatus_t status;
while (1) {
GPIOA->0DR ~= (@x1 << 5); //PA5 ON
vTaskDelay( 100);
do {
status = osMessageQueuePut(myQueueHandle, &msg[i], ©OU, @U);
} while ( status != 0sOK );
i++;
i= i & oxf; // restricted to 16 messages
osThreadYield(); // Suspend thread for a system tick
}
}
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void StartTask2(void *argument)

{

char str_tmp[100] =""; // To display formatted messages

MSGQUEUE_OBJ_t msg;

osStatus_t status;

while (1) {

status = osMessageQueueGet(myQueueHandle, &msg, NULL, 0U); // wait for message

if (status == 0sOK) {
GPIOA->ODR ”= (0x1 << 5); //PA5 ON
osDelay(50);

snprintf(str_tmp,100," %c %d \n\r", msg.Idx, msg.Buf[2]);
HAL_UART_Transmit(&huart1,( uint8_t * )str_tmp,sizeof(str_tmp),1000);

Realize Code

» Build “Project”
» Flash “binary code” on the h/w
» Reset h/w board (By pressing switch/button on the board)

» Monitor h/w board and “Tera-Term” Console window for the messages
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Exercise

This task is to demonstrate how to:

e Configure GPIO ports
o Create multiple Tasks in RTOS (Free RTOS)
e Generate A/D data (Task 1)

e Generate D/A data (Task 2)

MAIN()

TASKSTART()

Construct a C program to demonstrate and verify the design behaviour.
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Reference(s):

https://www.keil.com/pack/doc/CMSIS/RTOS2/html/group CMSIS RTOS SemaphoreMgmt.html

Review Questions
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